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Overview

• This guide walks a user though the steps to setup 

and configure a digital power device using Intersil’s 

PowerNavigator GUI.

• This guide assumes the user has followed the 

instructions on the website for downloading and 

installing PowerNavigator and is able to launch the 

program successfully.



Overview

• The following sections are shown in this guide:

– Hardware free mode
• Selection of devices

• Power architecture setup

• Current sharing

– Connecting to hardware
• Auto scan of devices

– Device setup with Rail Inspector
• Changing device parameters

• Configuration file load and save

– Sequencing
• Time based sequencing

• Event based sequencing

– RailScope
• Adding/monitoring devices

• Logging

– Production File Hex Creation



Offline Mode (Hardware Free Mode)



PowerNavigator 5.2 Launch Screen

Connected Devices Offline Mode Project Load

The PowerNavigator launch screen allows you to select online (hardware 

connected) or offline modes of operation.

Click on “Build New 

System” and then 

“Start”



PowerNavigator 5.2 – System Screen

Initial screen is a blank canvas, allowing the user to setup 

and configure an entire power system.

Part Library showing 

devices, sorted by 

device type



PowerNavigator 5.2 – System Screen

1. Grab any device or label and 

drag and drop into the PowerMap

2. Drop onto any node identified 

by a black square.



PowerNavigator 5.2 – System Screen

Devices from the same source 

can be added here

Drop parts on this 

node to cascade rails

Layout assistant will automatically appear 

when adding parts to PowerMap



PowerNavigator 5.2 – System Screen

Multiple parts can be added to PowerMap, representing 

system level view.

Individual RailBlock 

for each device



PowerMap RailBlock Overview

Example ZL8800 RailBlock (2-PH operation):

Controller Type Number of 

phases

PMBus Address

(0x22). -0 or -1 

signifies Page 0 or 

Page 1.

Online/Offline Status

PMBus Enable/ 

Disable

PGOOD Status

Rail Name (customizable) Vout/Iout Telemetry



PowerMap RailBlock Overview

Example ZL8800 RailBlock (2-CH operation):

Drag “Phase Dot” to 

change from 2-phase 

to 2-Channel operation

Drag and drop interface for 

configuration of a rail from 

2-phase to dual output.



PowerMap RailBlock Overview

Example ZL2102 RailBlock:

• Controllers which do not support current share will only have one “slot”.

• In this case, we have a single phase ZL2102 controller at PMBus address 

0x27.



PowerNavigator 5.2 – System Screen

Load Blocks represent system load. Double Click to add 

additional inputs.

Load block



Multi-input Load Boxes

Double Click Load to bring up 

Load Inspector dialog box

Hit “+” button to add 

additional inputs

1

2

Additional 

inputs are 

now added 

to load box

3



PowerNavigator 5.2 – System Screen

After Configuring system, sources, rails and loads can be 

wired together.

Multi-input 

Load Box



PowerNavigator 5.2 – System Screen

Source to 

Rail Wiring



PowerNavigator 5.2 – System Screen

Right-click on PowerMap to bring up contextual menu. Select 

“Auto Wire All Power Lines” to auto wire PowerMap.

Auto-wire



PowerNavigator 5.2 – System Screen

Fully wired PowerMap with multi-input loads.

Auto-wire



PowerNavigator 5.2 – System Screen

To implement a current sharing rail, drag a part from the 

part library onto an open RailBlock “slot”.



PowerMap RailBlock Overview

Example ZL8801 RailBlock (4-PH operation):

• The ZL8801 allows for 2-PH, 4-PH, 6-PH or 8-PH operation via current share.

• Each “slot” in the RailBlock represents shows how many controllers can be 

paralleled in a current share group.

• To create a current share group, a controller can be dragged from the part 

library into a “slot”, creating a current share rail.

• In this case, we have a 4-phase design, with two ZL8801 controllers – one at 

PMBus address 0x24 and another at 0x25.

Slot 1 Slot 2 Slot 3 Slot 4

Dots represent 

number of 

phases



PowerNavigator 5.2 – System Screen

ZL8801 4PH 

Current Share



Monitoring View

22

Adjustment on output 

voltage

Monitoring 

readouts for Vin, 

Vout, Iout, Iin

PGOOD indicator

Device rail name

Temperature monitors, 

internal for silicon junction 

temperature, external for 

the temp sensor on the 

board

Duty cycle and 

switching frequency

View configuration for 

display



Readouts
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Digital readout of 

output voltage

Analog readout with color indicators. Green is 

within normal limits, yellow in PMBus warning 

limits, red for exceeding OVP/UVP settings

Operation and fault lights

Clicking this button will open the 

window below allowing adjustment of 

limits



Monitoring: Changing Views
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For systems with a large number of rails, a 

different monitoring view can be selected.

1. Click on the config icon 

on the top right

2. Adjust the view properties to select 

horizontal or add/drop any filter selection



Connecting to Hardware



Connect to Hardware…
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• To connect to hardware, a USB to PMBus adapter 

(ZLUSBEVAL3Z, included with all demo kits) is 

required.

• STEP 1: Connect USB cable from PC to USB adapter

• STEP 2: Connect USB to PMBus adapter to demo 

board hardware

• STEP 3: Power demo board

• STEP 4: Launch PowerNavigator software



Connect to Hardware…
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USB to PMBus Adapter

ZL8800 2-Output Eval Board

ISL827x 25/33A Module

Connect 12Vin here

Multiple boards can be connected together



PowerNavigator 5.2 Launch Screen

Connected Devices Offline Mode Project Load

All discovered hardware is displayed in the “Scan Devices” window. The 

PMBus scan range can be adjust – default range is 0x10 to 0x7F.

Discovered hardware is 

displayed



PowerNavigator 5.2 – Connect to HW

PowerMap is automatically 

populated with attached 

hardware



PowerNavigator 5.2 – Connect to HW

PowerMap is automatically 

populated with attached 

hardware

System load can be added to 

PowerMap. RailBlocks can be 

wired to input source and load. 



PowerNavigator 5.2 – Project Save

To save a project, go to 

File -> Save

Saving a project will 

save any device 

configuration files, 

PowerMap setup, and 

PowerNavigator 

perspective settings.



PowerNavigator – Rail Inspector



PowerNavigator 5.2 – Rail Inspector

• Rail Inspector tool eases device configuration
– Double click on RailBlocks to bring up individual Rail Inspector for 

each device.

– Each device in PowerNavigator can have its own, customized Rail 

Inspector.

•Rail Inspector tool can be used to:
– Quickly see rail summary, including PMBus addresses, controller 

type, PMBus status, device options, fault status, etc.

– Save/Load Configuration Files

– Configure device using command tool

• Allows for future expandability
– Future releases of PowerNavigator will expand Rail Inspector 

features



PowerNavigator 5.2 – Rail Inspector

Double Click RailBlock to bring 

up Load Inspector window

1

Rail Inspector Window will appear
2



Example Rail Inspector – ZL8801

Rail Status

Load/Save Configuration Files

Device Parameters/Telemetry

Device Option Summary

Enable/Disable Output from 

within Rail Inspector

Rail Inspector Navigation



Example Rail Inspector – ZL8801

Select Command Tool in 

Rail Inspector

Command Line to select 

PMBus command
Send/Read commands 

to target device

Add/Remove command 

lines in command tool

Command window logs 

all changes



Example Rail Inspector – ZL8801

Clicking “Search” allows 

the user to quickly find 

any PMBus command the 

device supports



Sequencing



PowerNavigator 5.2 – System Screen

Sequencing Tab

The sequencing tab allows for power up and power down 

sequencing of devices in the PowerMap.



PowerNavigator GUI – Sequencing

Sequencing Tab in GUI



PowerNavigator 5.2 – Sequencing

• Event based sequencing waits for the device PGOOD 

to transition high (the event) before sequential rails 

start-up

– Sequence order is set by Prequel/Sequel using the SEQUENCE 

PMBus command

– TON_DELAY is used to set the time delay between sequenced rails 

•Timed based sequencing uses a timer from a 

global enable to sequence rails at start-up.

– TON_DELAY sets the sequence order on the way up. TOFF_DELAY 

sets the order on the way down.



Event Based Sequence Example

Checked for Event Based sequencing

5ms delay programmed between rails



Event Based Sequence Example

Checked for Event Based sequencing

5ms delay programmed between rails



Event Based Sequence Example

CH1: 0.9V

5ms

CH2: 1.2V

CH3: 1.5V

CH4: 3.3V

TON_DELAY sets the 

sequencing delay 

between rails

5ms 5ms



Telemetry

Sequence order is set by Ton_Delay

Time Based Sequence Example



Time Based Sequence Example

CH1: 0.9V

20ms

CH2: 1.2V

CH3: 1.5V

CH4: 3.3V

20ms 20ms

30ms

50ms

70ms

TON_DELAY sets the 

sequencing delay from the 

common enable signal



RailScope



PowerNavigator 5.2 – RailScope

• New RailScope allows the user to plot telemetry 

parameters from up to 4 devices.
– Similar to a Low Bandwidth Oscilloscope integrated into 

PowerNavigator.

– Allows user to plot multiple telemetry values at a time.

• Logging capability is also built-in.
– All telemetry values can be logged to a .csv file for later viewing.

– Status registers are also logged.

• Adjustable update rate allows users to control how 

much data they collect.
– Data can be updated as fast as 1ms and as slow as 1000ms.

– Displayed points can be as few as 50 to as many as 500.



PowerNavigator 5.2 - RailScope

Example Vout Plot

View up to 4 Rails at one time

Select up to 

4 telemetry 

parameters 

per device

RailScope 

controls

Enable/disable 

logging

Adjust Plot size

Real time telemetry showing 

device ramp-up!



RailScope: Initial Setup

If RailScope is not visible, go to View->RailScope

1

Double Click on the “Slots” 

to add rails to RailScope

2

In “Load Rail” window, select 

rail to add to each slot.

3

Click “Ok” 

when done

4



RailScope: Example View with 2 Telemetry Parameters

Vin and Vout 

Telemetry 

Parameters 

selected

Chart Area automatically 

splits into two graphs



RailScope: Example View with 4 Telemetry Parameters

Vin, Vout, 

Iout and 

Temp 

Telemetry 

Parameters 

selected

Chart Area automatically 

splits into four graphs



RailScope: Example Zoom-in

Click and drag to highlight 

zoom area in chart



RailScope: Example Zoom-in

Release mouse click to 

Zoom. Double left click to 

auto-zoom back out.



RailScope: Example X- & Y-axis Scale Options

Click Toolbox icon to bring 

up y-axis limits box

When “Auto Ranging” 

check box is clicked, 

PowerNavigator will auto-

set y-axis scale

Unchecking “Auto 

Ranging” box allows user 

to set upper and lower 

bounds

X-axis scale is set by 

update rate and display 

point user settings



RailScope: Logging Feature

• Once enabled, logging feature will 
automatically log all selected telemetry 
parameters and the STATUS_WORD 
register for each device.

• All data is saved to a .csv file, which can 
be opened in Excel for later data 
analysis.
– Once the .csv file size exceeds 50MB, a new file will 

automatically be created.
– There is no limit on how long logging can run for.

• The log file name and path can be 
changed by the end user. 



RailScope: Example Log File

Each telemetry entry 

is time stamped

Telemetry parameters for 

“VCCIO” rail

Rail name can be set 

by user (taken from 

PowerMap)

Telemetry parameters for 

“AUX” rail



Hex File Creation



Configuration File Overview

• Intersil Digital Power controllers use configuration files 

to program important device parameters.

– Configuration files are basically a list of PMBus commands defining device 

operation. i.e. Vout_Command = 1.0V, Iout_Cal_Gain = 0.5mV/A, etc…

• Device configuration only needs to be done one time –

programmed parameters are stored inside non-volatile 

memory for future use. NVM supports multiple writes and 

is re-programmable.

• Several Options are available for programming devices in 

a production environment.



Programming Devices in Manufacturing Environment

• Option 1: Program controllers pre-board assembly

– Devices are programmed on a high speed production programmer before 

being assembled on a board.

– Can use a supported 3rd party programming house OR offline programmer at 

sub-contractor.

• Option 2: Program controllers after board assembly

– Devices are programmed on PCB post board assembly

– Can be done at ICT (using a bed of nails approach or onboard microcontroller) 

OR using Intersil dongle and Production Configuration Tool (PCT).

– Requires board to be powered up with all controllers DISABLED until they are 

fully programmed.



Typical Flow – Pre-Programmed Devices

Finalize Config Files

Program Controllers

Pre-programmed controllers shipped to CM

Assemble/Test Boards

Convert config files to Hex 

format

Send Hex files to 3rd Party 

(if using) or Subcon

Finished Boards

• Controllers are programmed prior to PCB 

manufacture. 

• Hex files are created using 

PowerNavigator software (File->Export 

Production Hex).

• Programming is done either with a 3rd

party or using offline programmer at 

subcon.

• Typical programming time: 4-7 seconds 

per device.

• Individual part numbers are assigned to 

each device after programming to make 

sure boards are assembled correctly.



Typical Flow –Programming Parts on Board

Finalize Config Files

Program Controllers 

using dongle/PCT

• Controllers are programmed after 

board assembly.

• Typical Programming time: 5-10s 

per device.

• Simplified inventory and 

configuration file management.

• Controllers must be powered to 

program, but output must remain 

disabled until part is fully 

programmed.

• Special attention to sequencing 

must be made when using self-

enabled parts.

Assemble Boards

Power Board for Prog.

Prog. at ICT?

Power Board for Prog.

Prog. Using ICT test 

fixture/ bed of nails

Final Test

Finished Boards

YESNO



HEX File Creation – Step 1, Project Save

Step 1: To create a 

production HEX file, 

first save your project

NOTE: Before saving a project, 

the HW enable pin on all 

controllers must be held low.

NOTE: All Project files are stored in 

the directory: 

C:\Users\USERNAME\Documents\

Intersil\PowerNavigator\Projects



HEX File Creation – Step 2, Export HEX Files

Step 2: Go to File -> 

Export Production Hex

NOTE: All Production HEX files are 

stored in the saved project folder, 

located in the directory: 

C:\Users\USERNAME\Documents\Int

ersil\PowerNavigator\Projects

Click “Export”



Example Configuration File

Devices from PowerMap 

automatically populated

Programming address is 

address used on High 

Speed programmer socket

HEX file name can 

be set by user



Example Configuration File

Header information with device 

type, FW version, creation date, etc.

Programmed device parameters

This sequence of commands used 

to clear contents of NVM.



Example HEX File

Configuration file translated into 

machine readable hex format.
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